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How to Edit the Metadata of Project Pages on Bay-Delta Live
Welcome to the How to Edit the Metadata of a Project tutorial.
In this tutorial, we will go over how to edit the metadata of a project on Bay-Delta Live.

The metadata of a project is the title, description, author, type, keywords, etc. You can edit
all of this information using the metadata editor form.

To begin, be sure you are logged in by using the “Login” button at the top of the screen.

E m > Register

BAY-DELTA LIVE

Home Operations Current Conditions Weather and Tides Fish Projects Docs Maps Wiki Workgroups Data Catalog Explore Data

Turbidity Conditions in the Sacramento Delta

Understanding salinity and turbidity management allows us to look at things differently, understand
patterns and generate new ideas that might not arist U
interact on data in new ways and does not mand.

Once you are logged in, you can access the Project Library by clicking on the “Projects”
link in the top bar.

A VIX -

BAY-DELTA LIVE

Home Operations Current Conditions Weather and Tides F ou Projects Docs Maps Wiki Workgroups Data Catalog

Explore Data @

Fremont Weir Adult Fish Passage Modification
Project

The proposed Fremont Weir Adult Fish Passage Modification Project wotild widen
and deepen the existing fish ladder at the Fremont Weir. The'maximum target flow "3
through the fish passage structure would be limited to approximately 1,100 cubic
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The Project Library will open to the “What’s New” page. To access and search the entire
project library, click on “Search & List View” in the sub-navigation.

2] VX s EmEm .,

BAY-DELTA LIVE

Home Operations Current Conditions Weather and Tides Fish Projects Docs Maps Wiki Workgroups Data Catalog

Explore Data @

What's New Add Nev. Search & List View EcoRestore
PROJECTS
o e 1
i Y Fish Barrier at the Knights Landing Outfall Gates
Faded = \ o
Prospect Island Tidal Habitat Restoration Project
3 : 3 Yolo Basin Foundation
Ecun \;

Managed Agricultural Floodplain Habitat Investigation

The Nigiri Project: Salmon Habitat on Rice Fields

Wallace Weir Improvement Project

You can click through the project library or use the search function on the left-hand side.

What's New Add New Search & List View EcoRestore o I

SEARCH AND FILTER 2 Sort: Modifis | Show:24 % 22 Grid = Thumbnail = List Map Results g

My Docs | Public Docs
Data Source

<«

--all---

Project
Search
=TT
Type -
Sub Type Cache Collaborative
—all - s Publication Date: 2016-08-02  Modified: May 31, 2019 10:27 AM 2
Regions Keywords: Yolo, Cache, nasa_jpl_wq, Restoration, Ecosystem

Restoration, yolobypassdash

<«

--all---

Privacy Settings

Project

Public

«

@ Map Results [ Clear

Reset Extending the Arc
e

Author: Peter Moyle and Jon Durand
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Once you locate the project you want to edit, hover over the Tools menu and choose
“Edit” from the drop-down menu.

o

Education May 31, 2019 10:20 AM May 31, 2019 10:16 AM

View Project Education Research
@ Map Results [ Clear ™
View Project View Project

Private

Reset

a8 2%
— i G i
n T B View
e hamcomdB !
eid = 5 1 Share
Yolo Habitat Test Projegbiamdh & Project
____'— S 1 Conservation Plan _
- | & { Species and Habitat May 28,2019 0 019 01:46 PM
Conservation ) uplicate )
Restoratior storation

Add to Basket

Yolo Habitat Conservancy . . .

[P
Permalink ﬁ

May 31,2019 10:13 AM Delete

Preservation

View Project

e

The metadata editor form pops up. This form contains all the project’s metadata.

EDITING TEST PROJECT x

o

Title

Test Project

Caption/Short Description

Description .

Web Link (Opens a new window)

Meta Data URL

DOl

Let’s go through the options in each tab of the Editor form.
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First, the Main Tab.

EDITING TEST PROJECT x

Test Project

Caption/Short Description

Description .

Web Link (Opens a new window)

Meta Data URL

DOl

This is where you will enter a project’s Title and Description.
These two sections are important because the search function uses these words as
keywords when other users search for the project library.

EDITING TEST PROJECT x

Save Changes Cancel

Main | Favant | Man it | Puhlich? | Areaniza [ Vidan/Emhad | Draiact Infa

Title

I Test Project

Caption/Short Description

Description .

Web Link (Opens a new window)

Meta Data URL

DOl
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Another important section of the Main Tab is the Contact Information for the project. Be
sure to include the phone number or email address for the project contact here. This
information will populate on the “Recent Activity” page of the project.

Description

Web Link (Opens a new window)

Meta Data URL

Dol

. Contact Email Address

Save Changes Cancel

The next tab is the “Layout” tab.

EDITING TEST PROJECT x

Save Changes Cancel

Title I_

Test Project

Caption/Short Description

Description

Web Link (Opens a new window)

Meta Data URL
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The Default View drop-down menu includes all the page options of a project. Choose the
one you would like to have as the landing page for your project.

EDITING TEST PROJECT x

Save Changes Cancel

Man It! | Puhblich? | Oroanize | Viden/Fmhed | Praiact Infa

Default View

ARTICLE
Content Tabs
select all / deselect all
# ARTICLE « MAPS
2
v
¥IMAGES /VIDEO ¢\ )\ 1\ARY/REPORT
@ RECENT ACTIVITY ¥ DOCUMENTS -
« GRAPHS ¥ FILTERS
Content Addons
-none
Story

EC Dashboard
Turb Dashboard

Save Changes Cancel —

“Article” is a good option because you can customize the page to showcase important
information for the project.

“Recent Activity” is also a good option because it shows information like the project
members, description, contact information, and recent uploaded documents.
“Recent Activity” page example:

Recent Activity Article Documents Images & Video Maps Summaries & Reports
PROJECT DETAILS RECENT UPDATES MEMBERS AND FOLLOWERS
«§ Share & Invite B
There are currently no comments.
&+ Follow
Dolisl A
o
Description
The proposed project consists of NEW UPLOADS

constructing a positive fish barrier on
the downstream side of the existing
KLOG structure to prevent adult salmon
entry into the Colusa Basin Drain (CBD),
as well as repairing an erosion site on
the right bank of the CBD on the
downstream side of the KLOG structure.

Lutkemuller,
. N ) 1 Nicole
Knights Landing Outfall Gates Project - Notice

of...

Dewan,

Aimee Mobile, BDL
JPG

Announcing the Gate

fe

Author [ Source:
California EcoRestore

Palmieri,‘
n 2015 11 Water Notes Newsletter Brendan Osti, Dave

Contact

You can always come back and edit this later.
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Content Tabs gives you options for pages in your project.
You can select or deselect pages based on how you want to build your project.
If you are not sure which pages you would like to use, keep them all selected and come

back to edit this section later.

EDITING TEST PROJECT x

Save Changes Cancel
m Video/Embed | Project Info

Default View

ARTICLE 3
Content Tabs -
> select all / deselect all
@ ARTICLE « MAPS
@

v
@ IMAGES / VIDEO SUMMARY/REPORT
@ RECENT ACTIVITY @ DOCUMENTS -
@ GRAPHS @ FILTERS
Content Addons

--none --

Story

EC Dashboard

Turb Dashboard

Save Changes Cancel -

Next, go to the “Map It” tab.

EDITING TEST PROJECT x

Save Changes Cancel
Video/Embed | Project Info

Default View

ARTICLE B
Content Tabs -
select all / deselect all
@ ARTICLE « MAPS
@

v
@ IMAGES / VIDEO SUMMARY/REPORT
@ RECENT ACTIVITY @ DOCUMENTS -
@ GRAPHS @ FILTERS
Content Addons

--none --

Story

EC Dashboard

Turb Dashboard

Save Changes Cancel -
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This function assigns coordinates to your project so it can be viewed on a map, as well as
located when the map search function is used. For example, the project library map:

What's New Add New Search & List View EcoRestore

PROJECTS

Fish Barrier at the Knights Landing Outfall Gates

Prospect Island Tidal Habitat Restoration Project

Yolo Basin Foundation

Managed Agricultural Floodplain Habitat Investigation

The Nigiri Project: Salmon Habitat on Rice Fields

Wallace Weir Improvement Project

Factors Affecting the Abundance, Community Composition,

Enter the Latitude and Longitude or Click the “Open Map” button to select a point on the

map.

____ S
e o

EDITING TEST PROJECT

Save Changes
o o]

Cancel

m Video/Embed | Project Info

OpenMap | Click on the map to assign coordinates.

Latitude

Longitude

Save Changes

Cancel
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Once you select a point on the map, the coordinate values show up in the metadata editor
form.

EDITING TEST PROJECT x

Save Changes Cancel 5 ._f L | Bt w...’,‘ A

m Publish? Video/Embed | Project Info 7 4 \
OpenMap | Click on the map to assign coordinates. 6,;' R F @\
Latitude = Ve 4
_> 38.064540815354235 ‘\ 3
Longitude - =
4
ey | -121.7376378797421
Save Changes Cancel o O
)
Faur
S oA
17 B T e m

Next, go to the “Publish” tab.

EDITING TEST PROJECT x

»

OpenMap | Click on the map to assign coordinates.

Latitude
38.064540815354235

Longitude
-121.7376378797421

Save Changes Cancel
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The first section is the “Who May Access” drop-down menu.

You have two options here: “Me” and “PUBLIC/Everyone.” “Me” keeps the project private
and “PUBLIC/Everyone” gives the public access to view your project page.

Choose one.

EDITING TEST PROJECT x

Save Changes Cancel

> WHO MAY ACCESS

«

(Everything PUBLIC follows the Creative Commons non-commercial license.)

AUTHOR/SOURCE
PHOTO CREDIT
ORGANIZATION

COPYRIGHT

PUBLICATION DATE

The next sections are the Author/Source and the Organization information. If there are
specific people to name for the project, put them in Author/Source. Then fill out the
Organization section with the organizations and/or agencies involved in project. Be sure
to spell out the entire name of the organization.

EDITING TEST PROJECT x

Save Changes Cancel

WHO MAY ACCESS

Me

o

(Everything PUBLIC follows the Creative Commons non-commercial license.)

I AUTHOR/SOURCE

PHOTO CREDIT

' ORGANIZATION

COPYRIGHT

PUBLICATION DATE
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Next, fill out any copyright information.

EDITING TEST PROJECT x

Save Changes Cancel
v | vu o [ e v i i

WHO MAY ACCESS

o

Me

(Everything PUBLIC follows the Creative Commons non-commercial license.)

AUTHOR/SOURCE

PHOTO CREDIT

ORGANIZATION

> COPYRIGHT

PUBLICATION DATE

You can choose a publication date by clicking on the calendar icon.
The calendar will pop up so you can choose a date and it will auto-fill.

PHOTO CREDIT
ORGANIZATION

COPYRIGHT

PUBLICATION DATE
2019-05-28
—>| = P

HOMEPAGE VIEWER / MORE URL (Learn More URL)

%

PROMOTE (Allow for use in public places such as the home page viewer, home page news, or public RSS Feeds?)

No =

Save Changes Cancel

Revised June 2019 11



If you'd like to promote your project on BDL's homepage or the “What’s New” section of
the Project Library, choose “yes” or a specific option from the drop-down menu.

PHOTO CREDIT
ORGANIZATION

COPYRIGHT

PUBLICATION DATE
2019-05-28

iz [

HOMEPAGE VIEWER / MORE URL (Learn More URL)

/.

4> PROMOTE (Allow for use in public places such as the home page viewer, home page news, or public RSS Feeds?)

No s

Save Changes Cancel

Next, go to the “Organize” tab.

EDITING TEST PROJECT x

;
>
Q
&
4
@®
O
S
LY

o

Me

WHO MAY ACCESS
(Everything PUBLIC follows the Creative Commons non-commercial license.)

AUTHOR/SOURCE

PHOTO CREDIT

ORGANIZATION

COPYRIGHT

,,,,,

PUBLICATION DATE
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Choose a “Type” from the drop-down menu. People can search for projects by indicating a
specific “Type” so this will help them find your project.

For example, if your project is a research project, choose that option from the drop-down
menu.

EDITING TEST PROJECT x

Save Changes Cancel
Project Info

Video/Embed
R New Type**

TYPE

Research

e "WR New Subtype**

all 5

KEYWORDS

grizzly island, restoration, habitat

**These fields overide any value assigned from the respective selection boxes.
So for example: Typing "Rainforest" within "Other Type" will create a *“NEW* Type named "Rainforest", and assign this page to type
"Rainforest".

ICON

You can also choose a “Subtype” from the second drop-down menu if one is applicable.

EDITING TEST PROJECT x

[ Wain | Layout | map it | publish? Video/Embed | Project Info

TYPE OR New Type**
Research 5
SUBTYPE New Subtype**
all 5 T

grizzly island, restoration, habitat

**These fields overide any value assigned from the respective selection boxes.
So for example: Typing "Rainforest" within "Other Type" will create a *NEW* Type named "Rainforest", and assign this page to type
"Rainforest".

ICON
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The next section is the “Keywords” section. This is where you will write any words that
pertain to your project to optimize search capability. For instance, if you set “smelt” as one
of the keywords your project will show up in the results when someone types “smelt” into
the search box.

EDITING TEST PROJECT x

Save Changes Cancel

TYPE OR New Type**
Research 5
SUBTYPE OR New Subtype**
all A
KEYWORDS

—’ grizzly island, restoration, habitat

**These fields overide any value assigned from the respective selection boxes.
So for example: Typing "Rainforest" within "Other Type" will create a *“NEW* Type named "Rainforest", and assign this page to type
"Rainforest".

ICON

When you are finished filling out the information in the metadata editor form, be sure to
click “Save Changes.”

KEYWORDS

grizzly island, restoration, habitat

**These fields overide any value assigned from the respective selection boxes.
So for example: Typing "Rainforest" within "Other Type" will create a *“NEW* Type named "Rainforest", and assign this page to type
"Rainforest".

ICON

*An alternate icon - overrides content thumbnails etc..

» Save Changes Cancel
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You can always access the metadata editor form by hovering over the Tools menu and
choosing “Edit” from the drop-down menu.

SEARCH AND FILTER

Data Source

all

Search

Type
--all ---
Sub Type
--all ---
Regions
--all---
Privacy Settings
Private

@ Map Results [ Clear

What's New

<«

o

o

«

<«

Reset

Add New

Sort: Modifiy Show: 6 5

%

Test Project
Jun 06,2019 09:02 PM

Restoration

Project

Search & List View

My Docs

EcoRestore
22 Grid = Thumbnail = List
| Public Docs
Project Project

The Yolo Bypass Wildlife
Area Habitat and
Drainage Improvements
Project

Map Results g

Yolo Habitat
Conservation Plan

[Pl

P May 31,2019 10:25 AM

May 31, 2019 10:26 AM

View Project

28

Project m Project
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